Compaq StorageWorks
Command Console for RA200
Getting Started Guide

Part Number: AA–R0HJF–TE

First Edition (November 2001)

Product Version: 2.4

StorageWorks Command Console (SWCC) provides a method of monitoring, configuring, and troubleshooting storage subsystems from a remote location.
Compaq, the Compaq logo, and StorageWorks Registered in U. S. Patent and Trademark Office.
SANworks, Tru64, and OpenVMS are trademarks of Compaq Information Technologies Group, L.P. in the United States and other countries.
Microsoft, MS-DOS, Windows, and Windows NT are trademarks of Microsoft Corporation in the United States and other countries.
Intel is a trademark of Intel Corporation in the United States and other countries.
UNIX is a trademark of The Open Group in the United States and other countries.
All other product names mentioned herein may be trademarks of their respective companies.
Confidential computer software. Valid license from Compaq required for possession, use or copying. Consistent with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard commercial license.
Compaq shall not be liable for technical or editorial errors or omissions contained herein. The information in this document is provided “as is” without warranty of any kind and is subject to change without notice. The warranties for Compaq products are set forth in the express limited warranty statements accompanying such products. Nothing herein should be construed as constituting an additional warranty.
Compaq service tool software, including associated documentation, is the property of and contains confidential technology of Compaq Computer Corporation. Service customer is hereby licensed to use the software only for activities directly relating to the delivery of, and only during the term of, the applicable services delivered by Compaq or its authorized service provider. Customer may not modify or reverse engineer, remove, or transfer the software or make the software or any resultant diagnosis or system management data available to other parties without Compaq’s or its authorized service provider’s consent. Upon termination of the services, customer will, at Compaq’s or its service provider’s option, destroy or return the software and associated documentation in its possession.
Printed in the U.S.A.

Command Console for RA200 Getting Started Guide
First Edition (November 2001)
Part Number: AA–R0HJF–TE
# Contents

**About this Guide**
- Text Conventions ............................................................. vii
- Symbols in Text ................................................................. ix
- Symbols on Equipment ............................................................ ix
- Rack Stability ........................................................................ x
- Getting Help
  - Compaq Technical Support .................................................. xi
  - Compaq Website ..................................................................... xi
  - Compaq Authorized Reseller .................................................. xi

1 **About Command Console**
- How to Set Up This Software .................................................. 1–1
- About the Client ......................................................................... 1–2
- About the Agent ......................................................................... 1–3
- Command Console Features ..................................................... 1–3
- Client System Access Options ................................................... 1–3
- Client System Notification Options ............................................ 1–4
- Agent Access Password ........................................................... 1–5

2 **Connecting the Client to Your Storage Subsystems**
- Network Connection ............................................................... 2–1
- Operating System Considerations ............................................. 2–2

3 **Installing the Clients**
- Before You Begin ..................................................................... 3–1
- Installing the Clients
  - Installation ............................................................................. 3–2
  - About the Asynchronous Event Service ................................. 3–2
  - Stopping and Starting AES on Windows NT ......................... 3–3
  - Removing Command Console ............................................... 3–4

4 **Installing the RA200 Agents**
- Before Installing the RA200 Agent on OpenVMS ..................... 4–1
- Installing the RA200 Agent on OpenVMS .................................. 4–2
## Contents

- From the StorageWorks Web Site .................................................. 4–2
- Completing the Installation ......................................................... 4–2
- Removing the RA200 Agent from OpenVMS .................................. 4–3
- Before Installing the RA200 Agent on Tru64 UNIX ....................... 4–4
- Installing the RA200 Agent Locally on Tru64 UNIX ...................... 4–5
- From the StorageWorks Web Site .................................................. 4–6
- Completing the Installation ......................................................... 4–6
- Configuring Agent Event Logging on Tru64 UNIX ......................... 4–7
- Removing a Local Installation of the RA200 Agent from Tru64 UNIX . 4–8

### 5 Configuring the RA200 Agents

- Client System Access Options .................................................. 5–1
- Client System Notification Options ............................................ 5–2
- Agent Access Password ........................................................... 5–3
- Configuring the RA200 Agent on OpenVMS .................................. 5–4
  - Changing the Agent Access Password ...................................... 5–4
  - Adding a Client System Entry .................................................. 5–5
  - Modifying a Client System Entry ............................................. 5–6
  - Removing a Client System Entry ............................................ 5–7
  - Viewing a Client List ............................................................ 5–8
  - Restarting the RA200 Agent .................................................... 5–9
  - Stopping the Agent ............................................................... 5–10
  - Starting the Agent ................................................................. 5–11
  - Enabling and Disabling the Agent Startup at System Boot ............ 5–12
- Configuring the RA200 Agent on Tru64 UNIX .............................. 5–13
  - Changing the Agent Access Password ...................................... 5–13
  - Adding a Client System Entry .................................................. 5–14
  - Modifying a Client System Entry ............................................. 5–14
  - Removing a Client System Entry ............................................ 5–15
  - Viewing the Authorized Client List ........................................ 5–15
  - Restarting the RA200 Agent .................................................... 5–16
  - Stopping the Agent ............................................................... 5–16
  - Starting the Agent ................................................................. 5–16
  - Enabling and Disabling the Agent Startup at System Boot ............ 5–17

### A Usage Notes and Troubleshooting

- System Requirements ............................................................... A–1
- Enabling RA200 Host Event Logging ........................................ A–1
Enabling StorageWorks Fault Management for the RA200 ................. A–2
Firmware Upgrades for the RA200 ........................................... A–3
Specifying Command-Line Parameters .................................. A–3
Finding an Unzip Utility ......................................................... A–4
Network Port Assignments ..................................................... A–4
Requirements for TCP/IP Stacks on OpenVMS Version 7.2 ............ A–5
General Usage Notes ............................................................ A–6
Authorization Error When Adding an Agent System ................... A–7
Delayed Pager and Event Notification on RAS Connections .......... A–7
Increasing Screen Space for the Storage Window ...................... A–7
Invalid or Missing Fault Displays and Event Logs ..................... A–8
Continuous Pager Notification and Event Logging ..................... A–8
Starting Client with Network Connections .............................. A–9
Storage Window Does Not Display Status Changes .................. A–9
Multiple Communication Lost Messages ................................. A–10
Event Updates ................................................................. A–10
Multiple Pages ................................................................. A–10
Troubleshooting for RA200 Client and Agents ......................... A–10
Changing the RA200 Controller Settings ................................. A–11
Commands from the Storage Window Fail to Reach the RA200 Agent
Virtual Disk Initialization Warning .......................................... A–12
Initialization of Logical Drive Will Take Some Time .................. A–12
Troubleshooting Connection Problems .................................... A–12
Access Denied Problem ........................................................ A–12
Aliases Not Checked ............................................................ A–12
Client System Not on Agent's List ......................................... A–13
Entry in the Client Authorization List Does Not Match .............. A–13
Multiple Agents ............................................................... A–13
Add New System May Cause Client to Stop Responding ............. A–14
No Agent Running Message When Adding System to the Navigation Tree . . . A–14

Glossary

Index

Figures

2–1  An example of the network connection ................................. 2–2
## Tables

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Text Conventions</td>
<td>vi</td>
</tr>
<tr>
<td>1–1</td>
<td>Setting Up the Software</td>
<td>1–2</td>
</tr>
<tr>
<td>1–2</td>
<td>Client System Access Options</td>
<td>1–4</td>
</tr>
<tr>
<td>1–3</td>
<td>Client System Notification Options</td>
<td>1–4</td>
</tr>
<tr>
<td>4–1</td>
<td>Files in swcc22vms.exe</td>
<td>4–3</td>
</tr>
<tr>
<td>4–2</td>
<td>Program Files</td>
<td>4–5</td>
</tr>
<tr>
<td>4–3</td>
<td>Client System Access Options</td>
<td>4–8</td>
</tr>
<tr>
<td>4–4</td>
<td>Client System Notification Options</td>
<td>4–8</td>
</tr>
<tr>
<td>4–5</td>
<td>Program File</td>
<td>4–10</td>
</tr>
<tr>
<td>5–1</td>
<td>Client System Access Options</td>
<td>5–2</td>
</tr>
<tr>
<td>5–2</td>
<td>Client System Notification Options</td>
<td>5–2</td>
</tr>
<tr>
<td>A–1</td>
<td>Port Names and Default Numbers</td>
<td>A–5</td>
</tr>
<tr>
<td>A–2</td>
<td>Requirements for TCP/IP Stacks</td>
<td>A–6</td>
</tr>
</tbody>
</table>
About this Guide

The following sections are covered:

• Text Conventions
• Symbols in Text
• Symbols on Equipment
• Rack Stability
• Getting Help
• Compaq Authorized Reseller

Text Conventions

This document uses the conventions in Table 1 to distinguish elements of text.

<table>
<thead>
<tr>
<th>Element</th>
<th>Convention</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Named Keys</td>
<td>Bold</td>
<td>Home, Print Screen, Num Lock, Esc, PgUp</td>
</tr>
<tr>
<td>• Key Sequences</td>
<td></td>
<td>A plus sign (+) between two keys means that you should press them simultaneously: Ctrl+A, Ctrl+Home, Alt+Ctrl+Del</td>
</tr>
<tr>
<td>• Menu Items</td>
<td>Initial Caps</td>
<td>On the File menu, choose Save.</td>
</tr>
<tr>
<td>• Directory Names</td>
<td></td>
<td>Save the file in the C:\StorageSets\Default directory.</td>
</tr>
<tr>
<td>• Button Names</td>
<td></td>
<td>(UNIX, AIX, Solaris): Save the file in the /home/newuser/practice directory.</td>
</tr>
<tr>
<td>• Dialog Box Names</td>
<td></td>
<td>To back up files, click the Backup Now button.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>In the Save As dialog box, choose the drive then the folder.</td>
</tr>
</tbody>
</table>
### Table 1: Text Conventions (Continued)

<table>
<thead>
<tr>
<th>Element</th>
<th>Convention</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>• User Input and System Responses</td>
<td>Initial Caps and monospace font.</td>
<td>User Input and System Responses:</td>
</tr>
<tr>
<td>(Output and Error Messages)</td>
<td>COMMAND NAMES appear in upper case, unless they are case sensitive</td>
<td>• To exit from the program, type <strong>Exit</strong>.</td>
</tr>
<tr>
<td>• COMMAND NAMES</td>
<td>(UNIX, AIX, and Solaris command names are case sensitive and will not appear</td>
<td>• At the prompt, type this command:</td>
</tr>
<tr>
<td>• Drive Names</td>
<td>in uppercase).</td>
<td>SHOW THIS_CONTROLLER (no variable)</td>
</tr>
<tr>
<td></td>
<td>Entered &lt;variables&gt; are displayed in angle brackets (&lt; &gt;) and all lower</td>
<td>• To see your settings, give the command: SHOW &lt;storagesets&gt; FULL (with variable)</td>
</tr>
<tr>
<td></td>
<td>case.</td>
<td>• You will see the Continue? message.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Command Names</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Use <strong>SET THIS_CONTROLLER</strong> to change parameters.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• To manage storage, enter <strong>RUN sysmgr.exe</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• (UNIX, AIX, Solaris): To list files, give the <strong>ls</strong> command.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Drive Names: Navigate to your CD-ROM drive (usually <strong>D:</strong> or <strong>E:</strong>).</td>
</tr>
<tr>
<td>filenames</td>
<td>Unless case sensitive, use lowercase italics.</td>
<td>To configure storage, edit <strong>storageset.ini</strong>. Changes are stored in <strong>NewSystemConfigurationFile.ini</strong>. (UNIX, AIX, Solaris): Errors are logged to <strong>MixedCaseFile.txt</strong>.</td>
</tr>
<tr>
<td></td>
<td>If filenames are case-sensitive (UNIX, AIX, Solaris) or are easier to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>understand with some upper case letters, the exact case of each character</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is displayed.</td>
<td></td>
</tr>
<tr>
<td>Menu Command Sequences</td>
<td>Initial Caps, with a right angle bracket (&gt;) between items. Menu items</td>
<td>To compare documents, choose: Tools &gt; Documents &gt; Compare.</td>
</tr>
<tr>
<td></td>
<td>are displayed as shown on screen.</td>
<td></td>
</tr>
<tr>
<td>URLs</td>
<td>Sans serif font.</td>
<td>For update notices, visit:</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong><a href="http://www.compaq.com/products/updates">http://www.compaq.com/products/updates</a></strong></td>
</tr>
</tbody>
</table>
Symbols in Text

These symbols may be found in the text of this guide. They have the following meanings.

WARNING: Text set off in this manner indicates that failure to follow directions in the warning could result in bodily harm or loss of life or damage to equipment.

CAUTION: Text set off in this manner indicates that failure to follow directions could result in damage to equipment or loss of information.

IMPORTANT: Text set off in this manner presents clarifying information or specific instructions.

NOTE: Text set off in this manner presents commentary, sidelights, or interesting points of information.

Symbols on Equipment

Any enclosed surface or area of the equipment marked with these symbols indicates the presence of electrical shock hazards. Enclosed area contains no operator serviceable parts.

WARNING: To reduce the risk of injury from electrical shock hazards, do not open this enclosure.

Any RJ-45 receptacle marked with these symbols indicates a network interface connection.

WARNING: To reduce the risk of electrical shock, fire, or damage to the equipment, do not plug telephone or telecommunications connectors into this receptacle.
Any surface or area of the equipment marked with these symbols indicates the presence of a hot surface or hot component. Contact with this surface could result in injury.

WARNING: To reduce the risk of injury from a hot component, allow the surface to cool before touching.

Power supplies or systems marked with these symbols indicate the presence of multiple sources of power.

WARNING: To reduce the risk of injury from electrical shock, remove all power cords to completely disconnect power from the supplies and systems.

Any product or assembly marked with these symbols indicates that the component exceeds the recommended weight for one individual to handle safely.

WARNING: To reduce the risk of personal injury or damage to the equipment, observe local occupational health and safety requirements and guidelines for manually handling material.

Rack Stability

WARNING: To reduce the risk of personal injury or damage to the equipment, be sure that:

- The leveling jacks are extended to the floor.
- The full weight of the rack rests on the leveling jacks.
- In single rack installations, the stabilizing feet are attached to the rack.
- In multiple rack installations, the racks are coupled together.
- Only one rack component is extended at any time. A rack may become unstable if more than one rack component is extended for any reason.
Getting Help

If you still have a question after reading this guide, contact our service representatives or visit our website.

Compaq Technical Support

In North America, call the Compaq technical support at 1-800-OK-COMPAQ. This service is available 24 hours a day, 7 days a week.

NOTE: For continuous quality improvement, calls may be recorded or monitored.
Outside North America, call Compaq technical support at the nearest location.
Telephone numbers for worldwide technical support are listed on the Compaq website: http://www.compaq.com.

Be sure to have the following information available before you call Compaq:

- Technical support registration number (if applicable)
- Product serial numbers
- Product model names and numbers
- Applicable error messages
- Operating system type and revision level
- Detailed, specific questions

Compaq Website

The Compaq website has the latest information on this product, as well as the latest drivers. Access the Compaq website at:

Compaq Authorized Reseller

For the name of your nearest Compaq Authorized Reseller:

- In the United States, call 1-800-345-1518.
- In Canada, call 1-800-263-5868.
- Elsewhere, see the Compaq website for locations and telephone numbers.
About Command Console

This chapter describes StorageWorks Command Console and how to set up the software. Topics in this chapter include:

- How to Set Up This Software
- About the Client
- About the Agent
- Command Console Features
- Client System Access Options
- Client System Notification Options
- Agent Access Password

StorageWorks Command Console (SWCC) provides a method of monitoring, configuring, and troubleshooting storage subsystems from a remote location.

SWCC can be connected to your StorageWorks controller in several ways. Once connected, the program sends commands and interprets the responses sent by the controller or adapter. The user interface displays the logical layout and status of a selected subsystem. A subsystem is comprised of a controller and an array of physical devices attached to a host.

How to Set Up This Software

Before you can monitor your subsystem, you need to install and configure several components of this software. Table 1–1 provides a brief overview on how to set up the software:
About Command Console

Command Console is comprised of several components: the Command Console, the device-specific Clients, and the device-specific Agents. In this chapter, you will learn about these components and how they provide a graphical window into the operation of your subsystem.

To install the software, two steps are required, which can be done in any order, as discussed in the next two sections.

About the Client

The Client allows you to monitor and manage subsystems that are in a remote location. The Client runs on a local system with Microsoft NT version 4.0 or Windows 2000.

The Client is divided into two parts: the Command Console and the device-specific Client. The Command Console provides the Navigation window that you see when you click StorageWorks Command Console in Start > Programs > Command Console. This Navigation window provides you with the Navigation Tree, in addition to other functions. The Navigation Tree provides a way for you to manage your systems.

Table 1–1: Setting Up the Software

<table>
<thead>
<tr>
<th>Step</th>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Set up a connection for the Clients, Agents, and subsystems. (see Chapter 2)</td>
</tr>
</tbody>
</table>
| 2    | Install the Command Console and the device-specific Clients. (See Chapter 3)  
When you install the Command Console, the software will automatically install the following:  
• RA200 Client |
| 3    | Install the device-specific Agent on a system:  
• RA200 Agents (See Chapter 4) |
| 4    | Add the name of the client system to the Agent’s list of client system entries:  
• RA200 Agents (See Chapter 5) |
| 5    | Add the name of the agent system to the Navigation Tree.  
(Command Console Help) |
The device-specific Client (such as the RA200 Client) is an add-in for the Command Console. This add-in provides a Storage Window, which displays the status of a particular subsystem. Access the Storage Window by using the Navigation Tree.

**About the Agent**

The device-specific Agent is a companion program for the device-specific Client. You need to install the Agent on systems (hosts) that are accessible to both the Clients and the subsystems. The device-specific Agent collects data from the subsystems and passes the information along to the Client. The Agent also enables the Client to communicate with your subsystem over a network.

**Command Console Features**

The following is a list of Command Console features:

- Automatic event logging on Windows NT and Windows 2000
- Fault notification by pager
- Graphical view of the controller and its logical storage elements
- Network connection by means of Transmission Control Protocol/Internet Protocol (TCP/IP)
- Security to protect access to storage subsystems
- Status monitoring of the storage subsystem by using colored icons

**Client System Access Options**

The access privilege level controls the client system’s level of access to the storage subsystems. You can select Overall Status (no access), Detailed Status (show level access only), or Configuration (storage subsystem configuration capability). Table 1–2 lists the client system access options:
Table 1–2: Client System Access Options

<table>
<thead>
<tr>
<th>Options</th>
<th>SWCC Function</th>
</tr>
</thead>
</table>
| Overall Status (No Access)         | • Uses the Client software to add a system to a Navigation Tree, set up a pager, and view properties of the controller and the system.  
                        | • Does not use the Client to open a Storage Window.                           |
| Detailed Status (Show Level Access) | • Uses the Client software to open a Storage Window, but you cannot make modifications in that window.                       |
| Configuration (Storage Subsystem Configuration Capability) | • Uses the Client software to make changes in a Storage Window to modify a subsystem configuration. |

**Client System Notification Options**

The notification scheme defines the network protocol used by the Agent when notifying the selected client system of a change in the state of a subsystem. Table 1–3 describes how the TCP/IP and the Simple Network Management Protocol (SNMP) work with SWCC:

Table 1–3: Client System Notification Options

<table>
<thead>
<tr>
<th>Options</th>
<th>SWCC Function</th>
</tr>
</thead>
</table>
| TCP/IP  | • Automatically updates the Storage Window of subsystem changes provided the asynchronous event service (AES) is running.  
                        | • Required for Windows NT event logging and pager notification.              
                        | • If you do not select TCP/IP, you will need to refresh the Storage Window to obtain the latest status of a subsystem. |
Agent Access Password

You can change the configuration of a subsystem by using your Agent access password, provided that you have the configuration access privilege level selected.

Table 1–3: Client System Notification Options (Continued)

<table>
<thead>
<tr>
<th>Options</th>
<th>SWCC Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNMP</td>
<td>• Requires you to use an SNMP-monitoring program to view SNMP traps.</td>
</tr>
</tbody>
</table>
Connecting the Client to Your Storage Subsystems

This chapter describes the ways that you can connect your client systems to your subsystems:

- Network connection by means of the TCP/IP protocol

**Network Connection**

SWCC has sophisticated networking capabilities. If the Client is running on a local system with a TCP/IP network connection, you can connect SWCC to an Agent through the network. To connect, run the Command Console Agent program on your host.

The Agent acts as the Client’s assistant in controlling your storage subsystem. Commands sent from the Client are received by the Agent and are routed to the storage subsystem through the subsystem’s SCSI host bus. Subsystem status is transmitted back to the Client from the Agent through the network connection. You can also use the Agent for access protection.

By using a network connection, you can configure and monitor your storage subsystem from anywhere on your local area network (LAN). LAN is a network confined to a single geographic location. If you have a wide area network (WAN) or a connection to the Internet, you can monitor your subsystem with the TCP/IP network protocol. Figure 2–1 displays an example of a network connection:

**NOTE:** Command Console does not support the dynamic host configuration protocol (DHCP) or the Windows Internet Name Service (WINS).
Operating System Considerations

You can reconfigure the storage subsystems by using SWCC. For the operating system to properly reflect these changes, you may need to take action outside the scope of SWCC, such as initialize the drive or reboot the system. For further information, read the documentation for your operating system.
This chapter contains instructions on how to install the Client component of StorageWorks Command Console for Windows NT and Windows 2000 on Intel platforms. It also provides information on how to access the online version of this document.

When you install Command Console, you will also be installing the Clients for RA200 controllers. The RA200 Client provides the Storage windows. If you are installing the Clients with a network connection, you must also install the individual Agents for each system.

The following software is installed with Command Console:

- RA200 Client for the KZPSC and KZPAC controllers.

### Before You Begin

Refer to the ccclient.txt file before the installation. It contains any last-minute changes made to Command Console, in addition to known problems with this release.

Also, an online copy of this guide (GettingStarted.pdf) is available in .pdf format on the CD-ROM that accompanies this software. You need Adobe Acrobat Reader version 4.0 or later to view the .pdf files. There are two ways to obtain Adobe Acrobat Reader:

- From the StorageWorks Command Console CD–ROM.
- From the Adobe Web site:
  
  [www.adobe.com](http://www.adobe.com)

### Installing the Clients

This section contains instructions on how to install the Clients on the Windows NT operating system.
Installing the Clients

CAUTION: Before you install the Clients, do the following:

Check the software product description list located on the StorageWorks Web site. This list will tell you whether Command Console supports your hardware.

Verify that you are logged into an account that is a member of the administrator group.

If you have Command Console open, exit Command Console (File > Exit).

If you have Command Console version 1.1b or earlier, remove the program and the asynchronous event service.

If any of your shortcuts point to a floppy drive, a CD-ROM drive, or a removable drive, verify that the floppy or CD-ROM drives are not empty and that the removable drive is present. The installation will check the shortcuts on the desktop and in the Start menu. The installation will check the shortcuts of all users for the computer, even if they are not currently logged on.

Installation

At this point, you should have downloaded the file, swccv22client.exe for the Intel platform, from the StorageWorks Web site, to the computer that you want to use as your client system.

1. Open Windows Explorer and double click the file that you downloaded. The file self-extracts.

2. Go to the following directory and double click setup.exe. For the Intel platform double click NTIntel\client.

The AES starts and the following software installs:

- Command Console.
- RA200 Client for the KZPSC and KZPAC controllers.

For more information on AES, read section “About the Asynchronous Event Service” in this chapter.

NOTE: After Command Console is installed, you can access Help, which provides detailed information on the configuration and use of Command Console. You can access Help for Command Console by clicking Help in the window.

About the Asynchronous Event Service

The AES is a component of Command Console. It runs in the background as a service that provides status updates of the subsystems to its client system. For a client system to receive updates, it needs to be running AES. When AES is running, it passes the
Installing the Clients

trap (message) to the Navigation Tree. The Navigation Tree, in turn, passes the trap to the appropriate Storage windows. You can identify a new trap that has been passed to the Navigation Tree because the status of one or more of its icons will change.

AES can also send traps to pagers. To activate this function, you must predefine each pager number in the User Profile section of the Event Notification menu in the Navigation window.

**NOTE:** Consult Command Console’s Help for the latest information on how to diagnose problems that could occur when sending pages. Help provides instructions on how to put AES into a debug mode.

You can change whether AES starts at boot time. You can also stop or start AES. However, you need AES running to receive pages notifying you of faults and to provide updates to the Navigation Tree, Storage windows, and Windows NT Event Viewer. When you stop AES, you are telling the Client software to do the following on its client system:

- Stop providing updates to the Navigation Tree and Storage windows
- Stop displaying updates obtained from the AES in the Application Log of the Windows NT Event Viewer
- Stop paging others when a fault occurs

### Stopping and Starting AES on Windows NT

To stop or start AES:

1. Click Start > Settings > Control Panel > Services.
2. Double click the AsyncEventSvc entry. The Service window appears.
3. Click Stop or Start, then click Close.

To disable the automatic start of AES when your system boots, change the startup option to manual in the Services window, as described below:

1. Click Start > Settings > Control Panel > Services.
2. Double click the AsyncEventSvc entry. The Service window appears.
3. Select Manual under Startup Type, and click OK.
Removing Command Console

Perform the following steps to remove Command Console:

1. Click Start > Settings > Control Panel.

2. Double click the Add/Remove Programs icon. The Add/Remove Program Properties window appears.

3. Choose Command Console and then click Add/Remove. The following message appears:
   Are you sure you want to completely remove the selected application and all of its components?

4. Click Yes. Command Console is removed.

**NOTE:** The procedure described only removed Command Console. You can remove a device-specific Client by using the Add/Remove program (Start > Settings > Control Panel > Add/Remove Programs).
Installing the RA200 Agents

You need to install the RA200 Agent on a host in order for the RA200 Client software to receive information about your storage subsystems. The Agent software allows the Client to exchange information with your storage subsystem over a network.

This chapter contains instructions on how to install the RA200 Agents on Tru64 UNIX and Compaq OpenVMS operating systems.

Before Installing the RA200 Agent on OpenVMS

Perform the following steps before you install the RA200 Agent on OpenVMS:

1. Install Command Console on a computer that has Windows NT (See Chapter 3). That installation also installs the RA200 Client. If you prefer not to install the Clients now, you can install them after you have installed the Agent.

2. Verify that one of the following TCP/IP stacks is running on your system: MultiNet, TCPware, or UCX.

3. If you have OpenVMS version 7.2, verify that the TCP/IP stacks on your computer meet the requirements listed in section “Requirements for TCP/IP Stacks on OpenVMS Version 7.2” in Appendix A.

4. Verify that the RAID Array is running.

5. Verify that you have the appropriate firmware upgrades and drivers properly installed. For details, see section “System Requirements” in Appendix A.

6. Verify that StorageWorks Fault Management is enabled for each KZPAC and KZPSC controller that you want to manage with Command Console. For details, see section “System Requirements” in Appendix A.

7. If you are reinstalling the Agent, verify that you have stopped the Agent. Type the following at the command prompt and then press Return to stop the Agent:

   $ stop ccagentra200
Installing the RA200 Agent on OpenVMS

Instructions on how to install the RA200 Agent on OpenVMS operating system are as follows:

**CAUTION:** Before you install the Agent, complete the steps found in Before Installing the RA200 Agent on OpenVMS in this chapter.

These instructions are for installing the Agent on your system from a file downloaded from the StorageWorks Web site.

**NOTE:** Do not install the software over the network. Install the software on the system that is connected to the controller.

**From the StorageWorks Web Site**

At this point, you should have downloaded the file, `swcc22vms.exe` to the directory DKB100:[DOWNLOAD] from the StorageWorks Web site. In this section, you will tell the computer to uncompress the downloaded file before you begin the installation. For the following examples, you can replace DKB100:[DOWNLOAD] and DKB100:[RA200] with other names more suitable for your system.

1. At the command prompt, type the following and then press Return to create a directory named DKB100:[RA200]:

   ```
   $ CREATE/DIRECTORY DKB100:[RA200]
   ```

   **NOTE:** The directory will hold the self-extracted files for the RA200 Agent that runs on OpenVMS. Replace DKB100 with the name of your hard drive on the system connected to the controller.

2. At the command prompt, type the following and then press Return (Replace DKB100 with the name of your hard drive):

   ```
   $ SET DEFAULT DKB100:[RA200]
   ```

   Replace DKB100 with the name of the drive to which you will install the software.

3. At the command prompt, type the following and then press Return (This example assumes you downloaded the file into a directory named [DOWNLOAD]).
   (Replace DKB100 with the name of your hard drive):

   ```
   $ RUN DKB100:[DOWNLOAD]swcc22vms.EXE
   ```

   **NOTE:** You need to run `swcc22vms.exe` on OpenVMS. The `.exe` extension is used to assist Internet browsers in downloading the file.
4. At the command prompt, type the following and then press **Return**:

   `$ PRODUCT INSTALL *`

   The computer displays the programs that are included in the self-destructing zip file.

**Table 4–1: Files in swcc22vms.exe**

<table>
<thead>
<tr>
<th>File Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>dec-apvms-ccagentra200-v0201-316a-1.pcsivms</td>
<td>The RA200 Agent for OpenVMS version 7.1 or earlier</td>
</tr>
<tr>
<td>dec-apvms-ccagentra200-v0202-503-1.pcsivms</td>
<td>The RA200 Agent for OpenVMS version 7.2 or later</td>
</tr>
</tbody>
</table>

5. Choose one of the files for the RA200 Agent.

**Completing the Installation**

In this section, you will complete the installation that you began in the previous section.

1. Press **Return**. You will be asked to choose options, if any, for each selected product and for any products that may be installed to satisfy software dependency requirements. The Agent will start after the installation. The display shown below may vary from what is on your screen:
Installing the RA200 Agents

Configuration phase starting ...

DEC AXPVMS CCAGENTRA200 V2.2: StorageWorks Command Console RA200 Agent for OpenVMS AXP

© Compaq Computer Corporation 1998. All rights reserved.
Compaq Computer Corporation
This product does not use a PAK.
Do you want the defaults for all options? [YES] <return>
Do you want to review the options? [NO] <return>

Execution phase starting ...

The following product will be installed:
DEC AXPVMS CCAGENTRA200 V2.2Layered Product
Portion done: 0%...70%...80%...90%...100%

The following product has been installed:
DEC AXPVMS CCAGENTRA200 V2.2Layered Product

DEC AXPVMS CCRA200AGENT V2.2: StorageWorks Command Console RA200 Agent for OpenVMS AXP

Run @SYS$MANAGER:RA200CONFIG.COM to configure this product.
Insert the following lines in SYS$MANAGER:SYSTARTUP_VMS.COM:
@SYS$MANAGER:CCAGENTRA200$STARTUP.COM

2. The Agent starts automatically. You can check if the Agent is running by looking for the ccagentra200 process by typing the following at the command prompt and then pressing Return:

   $ SHOW SYS

   NOTE: For your client systems to communicate with this Agent, you need to first add those client systems to the Agent’s list of client system entries. For more information, see Chapter 5.

Removing the RA200 Agent from OpenVMS

Before you remove the RA200 Agent, you need to stop the Agent from monitoring the subsystems. Instructions on how to remove the RA200 Agent on OpenVMS operating system are the following:

1. Stop the Agent by using the Configuration menu, as described in Chapter 5.
2. At the command prompt, type the following and then press Return:

   $ PRODUCT REMOVE *
3. Type the corresponding number for the software that you want to remove.

4. To remove the configuration and Client list files, change to the sys$system directory and delete the following files (If you delete these files, you will need to reconfigure the Agent after reinstallation):

<table>
<thead>
<tr>
<th>File Name</th>
<th>File Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>RA200.CFG</td>
<td>Configuration File</td>
</tr>
<tr>
<td>RACLIENT.INI</td>
<td>Client List File</td>
</tr>
</tbody>
</table>

**Before Installing the RA200 Agent on Tru64 UNIX**

Perform the following steps before you install the RA200 Agent on Tru64 UNIX:

1. Install Command Console on a computer that has Windows NT. See section “Installing the Clients” in Chapter 3. That installation also installs the RA200 Client. If you prefer not to install the Clients now, you can install them after you have installed the Agent.

2. Remove previous versions of the RA200 Agent from your computer; otherwise, the installation will stop.

3. Log in as root (superuser).

4. Ensure that the RAID Array is running.

5. Verify that you have the appropriate firmware upgrades and drivers properly installed. For details, see section “System Requirements” in Appendix A.

6. Verify that StorageWorks Fault Management is enabled for each KZPAC and KZPSC controller that you want to manage with Command Console. For details, see section “System Requirements” in Appendix A.
Installing the RA200 Agent Locally on Tru64 UNIX

CAUTION: Before you install the Agent, complete the steps found in section “Before Installing the RA200 Agent on Tru64 UNIX” in this chapter.

From the StorageWorks Web Site
At this point, you should have downloaded the file, swcc22dunix.exe to the download directory from the StorageWorks Web site. In this section, you will tell the computer to uncompress the downloaded file before you begin the installation. For the following examples, you can replace the ../download and ../Agents directory names and paths with others more suitable for your system.

1. At the command prompt, type the following and press Return:
   # mkdir .../Agents

2. At the command prompt, type the following and then press Return:
   # cd .../Agents

3. At the command prompt, type the following and press Return:
   # mv .../download/swcc22dunix.exe    .../Agents

4. At the command prompt, type the following and press Return:
   # chmod +x   swcc22dunix.exe

5. At the command prompt, type the following and then press Return:
   # swcc22dunix.exe

   NOTE: You need to run swcc22dunix.exe on Tru64 UNIX. The .exe extension was added to assist Internet browsers in downloading the file.

6. At the command prompt, type the following and then press Return:
   # setld -I .../Agents

7. Choose the Agents that you want to install. You are asked if you want to install the listed subsets.
Completing the Installation

In this section, you will complete the installation that you began in the section, “Beginning the Installation.”

1. Type 2 and then press Return to install all of the listed subsets. You are shown the subsets that you have decided to install. A message, asking if your choice is correct, appears.

2. Type y and then press Return to continue with the installation. You are shown the number of subsets that will be installed, the copyright agreement, and a note warning you to remove previous versions of the Agent from your computer.

3. Press Return to continue. The software will check for existing installations found on the computer. If it does not find a previous version of the Agent, the software will do one of the following:
   a. Ask you to type a password. Your case-sensitive password must have 4 to 16 characters. Go to step 4.
   b. Tell you that it has already found existing configuration files and Return you to the command prompt.

   NOTE: If the software finds a previous version of the Agent, it will tell you to remove it. You cannot install the RA200 Agent until the previous version has been removed. Return to the command prompt.

4. Type your new password and then press Return. A message, asking you to verify the new password, appears.

5. Type your new password again and then press Return. A message, telling you that the password has been updated, appears.

6. Press Return to continue. The computer asks you to add a client system entry.

7. Type the name of a client system that will receive updates from this Agent and then press Return. The software displays a menu, giving you three choices for selecting the client system access level.

8. From the displayed menu, type an access level for the client system. Table 4–3 explains the client system access options:

10. Type a notification scheme for the client system: 0, 1, 2, 3, or 4.

The notification scheme defines the network protocol used by the Agent when notifying the selected client system of a change in the state of a subsystem. Table 4–4 describes how the TCP/IP and the SNMP work with SWCC:

<table>
<thead>
<tr>
<th>Options</th>
<th>SWCC Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCP/IP</td>
<td>• Automatically updates the Storage Window of subsystem changes provided AES is running.</td>
</tr>
<tr>
<td></td>
<td>• Required for Windows NT event logging and pager notification.</td>
</tr>
<tr>
<td></td>
<td>• If you do not select TCP/IP, you will need to refresh the Storage Window to obtain the latest status of a subsystem.</td>
</tr>
<tr>
<td>SNMP</td>
<td>• Requires you to use an SNMP-monitoring program to view SNMP traps.</td>
</tr>
</tbody>
</table>

Table 4–3: Client System Access Options

<table>
<thead>
<tr>
<th>Options</th>
<th>SWCC Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 = Overall Status (No Access)</td>
<td>• Uses the Client to add a system to a Navigation Tree, set up a pager, and view properties of the controller and the system.</td>
</tr>
<tr>
<td></td>
<td>• Does not use the Client to open a Storage Window.</td>
</tr>
<tr>
<td>1 = Detailed Status (Show Level Access)</td>
<td>• Uses the Client to open a Storage Window, but you cannot make modifications in that window.</td>
</tr>
<tr>
<td>2 = Configuration (Storage Subsystem Configuration Capability)</td>
<td>• Uses the Client to make changes in a Storage Window to modify a subsystem configuration.</td>
</tr>
</tbody>
</table>
11. Press **Return**. The computer asks you if the entered information is correct.

12. Type *y* and then press **Enter**. A message, asking if you would like to add another Client, appears.

13. Type *y* and then press **Enter**. If you want to add another client system, repeat steps 6 through 12.

   OR

   Type *n* and then press **Enter** for the main menu.

**NOTE:** Add this system to the Navigation Tree of each client system that you added to the Agent's list (File > Add System in Command Console). Refer to the Command Console Help.

### Configuring Agent Event Logging on Tru64 UNIX

Events are logged by the Command Console Agent to Tru64 UNIX logging facility by using the syslog standard C Library function (man reference syslog[3]). When the syslog function is executed, the priority specified during the call is “notice.” The openlog standard C library function (man reference syslog[3]), which is used prior to the syslog function, specifies the facility as LOG_USER (messages generated by user processes).

To ensure that logging occurs for the Command Console Agent on Tru64 UNIX, the /etc/syslog.conf file (man reference syslog[8]) must be configured to include an entry to direct logging for the user facility. This entry must have a priority equal to or greater than the notice priority. In other words, if logging currently does not occur for the user facility, you must create an entry similar to the following in the syslog.conf file:

```
user.notice /var/adm/syslog.dated/user.log
```

If an entry already exists in the syslog.conf file that logs user messages and has the same priority or higher than notice, you do not need to add an entry in the above format. This will result in duplicate logs.

Tru64 UNIX Agent is installed as a background task. The Agent will run continuously after it is installed.
Removing a Local Installation of the RA200 Agent from Tru64 UNIX

To remove the RA200 Agent from your computer, you will need to know the subset that you installed. When you installed this Agent, the software detected the version of Tru64 UNIX on your computer and installed the appropriate subset. A subset is a version of the Agent program.

1. At the command prompt, type the following and then press Return:

   # setld -i | grep SWCC

   You will see one or both of the subsets. Your computer is using the subset that has the word, “installed,” next to it. If you do not see one of these subsets, verify that you have installed the RA200 Agent that came with this kit.

2. At the command prompt, type the following and then press Return. The Configuration menu appears.

   # /usr/sbin/RA200config.sh

3. Type 2 and then press Return to stop the Agent. You are given the status of the Agent and asked if you would like to stop or restart the RA200 Agent.

4. Type s and then press Return to stop the Agent. The software stops the Agent.


6. Press q and then press Return to leave the Configuration menu.

7. At the command prompt, type the following and then press Return to remove the RA200 Agent: (This example is for subset SWCCRA210.)

   # setld -d SWCCRA210

8. To remove the configuration and Client list files, change to the /etc directory and delete the following files. If you delete these files, you will need to reconfigure the Agent during reinstallation. Table 4–5 lists the program files:

<table>
<thead>
<tr>
<th>File Name</th>
<th>File Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>RA200.CFG</td>
<td>Configuration File</td>
</tr>
<tr>
<td>RACLIENT.INI</td>
<td>Client List File</td>
</tr>
</tbody>
</table>
This chapter contains instructions on how to configure the RA200 Agents on Compaq OpenVMS and Tru64 UNIX. Topics in this chapter include:

- Client System Access Options
- Client System Notification Options
- Agent Access Password
- Adding a Client System Entry
- Changing the Agent Access Password
- Modifying a Client System Entry
- Removing a Client System Entry
- Viewing a Client List (OpenVMS, UNIX)
- Restarting the Agent (OpenVMS, UNIX)
- Starting and Stopping the Agent
- Enabling and Disabling the Agent Startup at System Boot
- Modifying TCP/IP Port Numbers Used by the Agent and Clients (Windows NT)

**Client System Access Options**

The access privilege level controls the client system’s level of access to the storage subsystems. You can select overall status (no access), detailed status (show level access only), or configuration (storage subsystem configuration capability). Table 5–1 lists the client system access options:
Configuring the RA200 Agents

Table 5–1: Client System Access Options

<table>
<thead>
<tr>
<th>Options</th>
<th>SWCC Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overall Status (No Access)</td>
<td>• Uses the Client to add a system to a Navigation Tree, set up a pager, and view properties of the controller and the system</td>
</tr>
<tr>
<td></td>
<td>• Does not use the Client to open a Storage Window</td>
</tr>
<tr>
<td>Detailed Status (Show Level Access)</td>
<td>• Uses the Client to open a Storage Window, but you cannot make modifications in that window</td>
</tr>
<tr>
<td>Configuration (Storage Subsystem Configuration Capability)</td>
<td>• Uses the Client to make changes in a Storage Window to modify a subsystem configuration</td>
</tr>
</tbody>
</table>

Client System Notification Options

The notification scheme defines the network protocol used by the Agent when notifying the selected client system of a change in the state of a subsystem. Table 5–2 describes how the TCP/IP and the SNMP work with SWCC:

Table 5–2: Client System Notification Options

<table>
<thead>
<tr>
<th>Options</th>
<th>SWCC Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCP/IP</td>
<td>• Automatically updates the Storage Window of subsystem changes provided AES is running</td>
</tr>
<tr>
<td></td>
<td>• Required for Windows NT event logging and pager notification</td>
</tr>
<tr>
<td></td>
<td>• If you do not select TCP/IP, you will need to refresh the Storage Window to obtain the latest status of a subsystem.</td>
</tr>
<tr>
<td>SNMP</td>
<td>• Requires you to use an SNMP-monitoring program to view SNMP traps</td>
</tr>
</tbody>
</table>
Agent Access Password

You can change the configuration of a subsystem (for example, upgrade firmware) by using your Agent access password, provided that you have the configuration access privilege level.

Configuring the RA200 Agent on OpenVMS

You will use the SWCC RA200 Agent Configuration menu to configure your RA200 Agent on OpenVMS operating system. This menu is divided into two areas (Agent Administration Options and Client Options). Type the following at the command prompt and then press Return to access this menu:

$ @sys$manager:ra200config.com

The following is an example of the menu:

<table>
<thead>
<tr>
<th>Agent Administration Options:</th>
</tr>
</thead>
<tbody>
<tr>
<td>------------------------------</td>
</tr>
<tr>
<td>1) Change Agent password</td>
</tr>
<tr>
<td>2) Start/Stop the Agent</td>
</tr>
<tr>
<td>3) Toggle Agent Startup at system boot</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Client Options:</th>
</tr>
</thead>
<tbody>
<tr>
<td>----------------</td>
</tr>
<tr>
<td>4) Add a Client</td>
</tr>
<tr>
<td>5) Remove a Client</td>
</tr>
<tr>
<td>6) Modify a Client</td>
</tr>
<tr>
<td>7) View Clients</td>
</tr>
<tr>
<td>Q) Quit</td>
</tr>
</tbody>
</table>

Changing the Agent Access Password

The password controls access to operations that modify the Agent configuration. To change the Agent access password, perform the following steps:

1. At the command prompt, type the following and then press Return. The Configuration menu appears.

   $ @sys$manager:ra200config.com
2. Type 1 and then press Return. The following appears:

   Changing Agent Password
   ------------------------
   Enter a new password (4 - 16 characters):

3. Type your password and then press Return.

4. Retype your password for verification and then press Return. The following appears:

   The Agent's password has been successfully updated!

   NOTE:  You must restart the SWCC RA200 Agent for changes to take effect.


6. Restart the Agent for your changes to take effect. For instructions, refer to the section “Restarting the RA200 Agent” in this chapter.

Adding a Client System Entry

For a client system to receive updates from the Agent, you must add it to the Agent’s list of client system entries. The Agent will only send information to client systems that are on this list. The following steps tell you how to add a client system entry:

   NOTE:  Put your most important client systems at the top of this list and the client systems that are connected infrequently to the network at the bottom. The Agent first contacts the client systems that are located at the top of the list.

1. At the command prompt, type the following and then press Return. The Configuration menu appears.

   $ @sys$manager:ra200config.com

2. Type option 4 and then press Return. The following appears:

   Add a client system
   -------------------
   Enter the host name of the client system (return to exit):
3. Type the name of the client system, for example rain.tre.wet.com, and then press Return. The computer displays the following:

<table>
<thead>
<tr>
<th>Enter the subsystem access privilege (which controls the level of access a Client has for communicating with storage subsystems). The possible options are:</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 = Overall Status</td>
</tr>
<tr>
<td>1 = Detailed Status</td>
</tr>
<tr>
<td>2 = Configuration</td>
</tr>
</tbody>
</table>

Enter Access Level (0, 1, 2):

**NOTE:** The access privilege level controls the client system’s level of access to the storage subsystems. For a definition of each access privilege level, see section “Client System Access Options” in this chapter.

4. Type the number for the corresponding subsystem access privilege, for example 1, and then press Return. The following notification schemes available appear:

<table>
<thead>
<tr>
<th>Enter Error Notification Level (0, 1, 2, 3):</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 = No Error Notification</td>
</tr>
<tr>
<td>1 = Notification via a TCP/IP Socket</td>
</tr>
<tr>
<td>2 = Notification via the SNMP protocol</td>
</tr>
<tr>
<td>3 = Notification via both TCP/IP and SNMP</td>
</tr>
</tbody>
</table>

**NOTE:** The notification schemes defines the network protocol to be used by the Agent when notifying the client system of a selected change in the state of a subsystem. For a definition of the client system notification options, see section “Client System Notification Options” in this chapter.

5. Type the number for the corresponding notification level for the subsystem, for example 0, and then press Return. The Agent server can notify a client system when an error condition occurs. The following appears:

Adding Client--
name: rain.tre.wet.com
access level: 1
error notification: 0

Is this information correct? [y,N]:

6. If the information is correct, type Y and then press Return.

**NOTE:** Note: You must restart the SWCC RA200 Agent for changes to take effect.

Would you like to add another Client? [y,N]:

7. If you do not want to add another client system entry, type N and then press Return. The Configuration menu appears.
8. Restart the Agent for your changes to take effect. For instructions, see section, Restarting the RA200 Agent, in this chapter.

9. Add this system to the Navigation Tree of each client system that you added to the Agent’s list (File > Add System in Command Console). Refer to Command Console Help.

Modifying a Client System Entry

To modify a client system entry, perform the following steps:

1. At the command prompt, type the following and then press Return. The Configuration menu appears.

   $ @sys$manager:ra200config.com

2. To modify a client system entry, type 6 and then press Return. The following appears:

   Modify a Client System
                        ------------
   Host Name          Access Level     Error Notification
   ------------------  ---------------  ---------------
   bigearmouse.cat.cmr.com  Configuration    via TCP/IP
   mountain.rat.tre.com     Configuration    via TCP/IP and SNMP
   water.ari.sea.com       Overall Status   No Notification
   rain.tre.wet.com        Detailed Status  No Notification

   Enter the Client name (return to exit):

3. Type the client system’s case-sensitive name, for example rain.tre.wet.com, and then press Return. The following appears:

   Current settings for Client rain.tre.wet.com are:  
   1) Access level - Detailed Status 
   2) Error notification scheme - No Notification

   Which entry would you like to change (c to cancel, d if done)?
4. Type the corresponding number of the option that you would like to change, for example 1, and then press Return. The following appears:

```
The possible options are:
0 = Overall Status
1 = Detailed Status
2 = Configuration
New access level? (0, 1, 2):
```

For a definition of each access privilege level, see section “Client System Access Options” in this chapter.

5. Type the corresponding number for an access level, for example 2, and then press Return. The following appears:

```
Current settings for Client rain.tre.wet.com are:
1) Access level - Configuration
2) Error notification scheme - No Notification
Which entry would you like to change (c to cancel, d if done)?
```

6. Type the corresponding number of the option that you would like to change, for example 2, and then press Return. The following appears:

```
The possible options are:
0 = No Error Notification
1 = Notification via TCP/IP
2 = Notification via SNMP
3 = Notification via both TCP/IP and SNMP
New error notification scheme? (0, 1, 2, 3):
```

7. Type the corresponding number for the error notification scheme, for example 3, and then press Return.

```
Current settings for Client rain.tre.wet.com are:
1) Access level - Configuration
2) Error notification scheme - via TCP/IP and SNMP
Which entry would you like to change (c to cancel, d if done)?
```

8. Type D and then press Return when you are done. You are told that your entry has been modified and to restart the RA200 Agent for your changes to take effect.

10. Restart the Agent for your changes to take effect. For instructions, see section, Restarting the RA200 Agent, in this chapter.

**Removing a Client System Entry**

When you remove a client system entry from the Agent’s list, you are telling the Agent to no longer send updates to that client system. In addition, you will no longer be able to access this agent system from the Navigation Tree. The following instructions tell you how to remove a client system entry:

1. At the command prompt, type the following and press **Return**. The Configuration menu appears.
   
   $  @sys$manager:ra200config.com

2. Type 5 and then press **Return**. The following appears:

   (Table)

<table>
<thead>
<tr>
<th>Host Name</th>
<th>Access Level</th>
<th>Error Notification</th>
</tr>
</thead>
<tbody>
<tr>
<td>mountain.rat.tre.com</td>
<td>Configuration</td>
<td>via TCP/IP</td>
</tr>
<tr>
<td>water.ari.sea.com</td>
<td>Overall Status</td>
<td>No Notification</td>
</tr>
<tr>
<td>rain.tre.wet.com</td>
<td>Configuration</td>
<td>via TCP/IP and SNMP</td>
</tr>
</tbody>
</table>

   Enter the Client name (return to exit):

3. Type the client system entry that you would like to remove, and then press **Return**. The following appears:

   Are you sure you want to remove rain.tre.wet.com [y,N]:

4. Type Y and then press **Return**. You are told that the client system entry you specified has been removed from the client list and to restart the RA200 Agent for your changes to take effect.

5. Press **Return**. The Configuration menu appears.

6. Restart the Agent for your changes to take effect. For instructions, see section “Restarting the RA200 Agent” in this chapter.
Viewing a Client List

To view the Clients, perform the following steps:

1. At the command prompt, type the following and then press **Return**. The Configuration menu appears:
   
   ```
   $ @sys$manager:ra200config.com
   ```

2. Type 7 and then press **Return**. The following appears:

<table>
<thead>
<tr>
<th>Host Name</th>
<th>Access Level</th>
<th>Error Notification</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>mountain.rat.tre.com</td>
<td>Configuration</td>
<td>via TCP/IP</td>
<td></td>
</tr>
<tr>
<td>water.ari.sea.com</td>
<td>Overall Status</td>
<td>No Notification</td>
<td></td>
</tr>
<tr>
<td>rain.tre.wet.com</td>
<td>Configuration</td>
<td>via TCP/IP and SNMP</td>
<td></td>
</tr>
</tbody>
</table>


Restarting the RA200 Agent

You must restart the Agent after making any changes to the configuration. To restart the Agent, perform the following steps:

1. At the command prompt, type the following and press **Return**. The Configuration menu appears:

   ```
   $ @sys$manager:ra200config.com
   ```

2. Type 2 and then press **Return**. You are given the status of the Agent and asked if you would like to stop or restart the RA200 Agent or return to the Configuration menu.

3. Type R and then press **Return**. The Agent is restarted.

4. Press **Return** for the Configuration menu.
Configuring the RA200 Agents

Stopping the Agent

When you stop the Agent, it stops monitoring the storage connected to the KZPSC and KZPAC controllers. To stop the Agent, perform the following:

1. Verify that the RA200 Storage Windows on all of your client systems are closed.
2. At the command prompt, type the following and press Return. The Configuration menu appears:
   
   $ @sys$manager:ra200config.com

3. Type 2 and then press Return. You are given the status of the Agent and asked if you would like to stop or restart the RA200 Agent.
4. Type S and then press Return. The software stops the Agent.
5. Press Return for the Configuration menu.

Starting the Agent

To start the Agent, perform the following:

1. Verify that the RA200 Storage Windows on all of your client systems are closed.
2. At the command prompt, type the following and then press Return. The Configuration menu appears:
   
   $ @sys$manager:ra200config.com

3. Type 2 and then press Return. You are given the status of the Agent and asked if you would like to start the RA200 Agent.
4. Type Y and then press Return. The software starts the Agent.
5. Press Return for the Configuration menu.

Enabling and Disabling the Agent Startup at System Boot

The default is for the Agent not to start at system boot; however, you may find it useful to have the Agent start at system boot. The following instructions tell you how to change the default:

1. At the command prompt, type the following and then press Return. The Configuration menu appears:
   
   $ @sys$manager:ra200config.com
2. Type 3 and then press Return to enable the Agent to start at system boot. You are
told the startup at system boot is currently disabled, and you are asked if you
would like to enable this option.
3. Type Y and then press Return. The Agent will start at system boot.
4. Press Return for the Configuration menu.
5. You can return the Agent startup option to the system default by repeating
   steps 1–4. When you repeat the steps, you will be asked if you want to disable the
   Agent startup at system boot.

Configuring the RA200 Agent on Tru64 UNIX

This section describes how to configure the Agent by using the Configuration menu.

1. Type the following at the command prompt and then press Return. The following
   menu appears:

   # /usr/sbin/RA200config.sh

   Agent Administration Options:
   ----------------------------
   1) Change Agent password
   2) Start/Stop the Agent
   3) Toggle Agent Startup at system boot

   Client Options:
   ---------------
   4) Add a Client
   5) Remove a Client
   6) Modify a Client
   7) View Clients
   Q) Quit

   Enter Selection:
Changing the Agent Access Password

The password controls access to operations that modify the Agent configuration. To change the Agent access password for the RA200 Agent on Tru64 UNIX system, perform the following steps:

1. At the command prompt, type the following and press Return. The Configuration menu appears:
   
   `# /usr/sbin/RA200config.sh`

2. Type 1 to change the Agent access password and then press Return. A message, telling you to type a new password, appears. Your case-sensitive password must be 4 to 16 characters.

3. Type your new password and then press Return. A message, asking you to verify the new password, appears.

4. Type your new password again and then press Return. You are told that your password has been updated and to restart the RA200 Agent for your changes to take effect.


6. Restart the Agent for your changes to take effect. For instructions, see section “Restarting the RA200 Agent” in this chapter.

Adding a Client System Entry

For a client system to receive updates from the Agent, you must add the client system to the Agent’s list of client system entries. The Agent will only send information to client systems that are on this list. In addition, adding a client system entry allows you to access the agent system from the Navigation Tree on that client system. The following steps tell you how to add a client system entry:

NOTE: Put your most important client systems at the top of this list and the client systems that are connected infrequently to the network at the bottom. The Agent first contacts the client systems that are located at the top of the list.

1. At the command prompt, type the following and then press Return. The Configuration menu appears:
   
   `# /usr/sbin/RA200config.sh`

2. Type 4 to add a Client and then press Return. A message, asking you to type the name of the client system, appears.
3. Type the name for the new client system and then press **Return**. The following appears:

<table>
<thead>
<tr>
<th>0 = Overall Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 = Detailed Status</td>
</tr>
<tr>
<td>2 = Configuration</td>
</tr>
</tbody>
</table>

For a definition of each access privilege level, see section, Client System Access Options, in this chapter.

4. Type the access level for the new client system entry, and then press **Return**. The following appears:

<table>
<thead>
<tr>
<th>0 = No Error Notification</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 = Notification via a TCP/IP Socket</td>
</tr>
<tr>
<td>2 = Notification via the SNMP Protocol</td>
</tr>
<tr>
<td>3 = Notification via both TCP/IP and SNMP</td>
</tr>
</tbody>
</table>

**NOTE:** For more information on the notification schemes, see section “Client System Notification Options” in this chapter.

5. Type an error notification scheme for the client system entry, and then press **Return**. The computer asks you if the entered information is correct.

6. Type **y** if the information is correct and then press **Return**. You are asked if you want to add another client system entry.

7. If you are finished, type **n** and then press **Return**. You return to the Configuration menu.

8. Restart the Agent for your changes to take effect. For instructions, see section, Restarting the RA200 Agent, in this chapter.

### Modifying a Client System Entry

Instructions for changing the client system’s current access level and error notification scheme are as follows:

1. At the command prompt, type the following and press **Return**. The Configuration menu appears:

   ```
   # /usr/sbin/RA200config.sh
   ```

2. Type 6 to modify a client system entry and then press **Return**. The computer displays the added client system entries with their access level and error notification scheme. You are then asked for the entry that you want to modify.
3. Type the client system’s name and then press Return. The current settings of the client system are displayed, as shown in the following example:

```
Current settings for client 'rain.tre.wet.com' are:
  1) Access level - Configuration
  2) Error notification scheme - Notification via the SNMP protocol
Which entry would you like to change (c to cancel, d if done)?
```

4. Type 1 and then press Return to change the current access level of the client system. You have three choices:

```
0 = Overall Status
1 = Detailed Status
2 = Configuration
```

NOTE: For a definition of each access privilege level, see section “Client System Access Options” in this chapter.

5. Type the corresponding number for a new access level for the client system, for example 1, and then press Return. The software displays the new settings for the client system.

6. Type 2 and then press Return to change the error notification scheme. The software displays the following menu:

```
0 = No Error Notification
1 = Notification via a TCP/IP Socket
2 = Notification via the SNMP Protocol
3 = Notification via both TCP/IP and SNMP
```

7. At the command prompt, type the new error notification scheme for the client system entry, for example 2, and then press Return. The software displays the new settings for the client system.

8. If you are finished, type d and then press Return. You are told that your entry has been modified and to restart the RA200 Agent for your changes to take effect.

9. Press Return. You return to the Configuration menu.

10. Restart the Agent for your changes to take effect.

NOTE: For instructions, see section “Restarting the RA200 Agent” in this chapter.
Removing a Client System Entry

When you remove a client system from the Agent’s list, you are telling the Agent to no longer send updates to that client system. In addition, you will no longer be able to access this agent system from the Navigation Tree. The following instructions tell you how to remove a client system entry:

1. At the command prompt, type the following and then press Return. The Configuration menu appears:

   ```
   # /usr/sbin/RA200config.sh
   ```

2. Type 5 to remove a client system and then press Return. The computer displays the added client system entries with their access level and error notification scheme. You are then asked for the client system entry that you want to remove.

3. Type the name of the client system entry that you want to remove and then press Return. A message, asking if you are sure about removing the client system, appears.

4. Type y and then press Return to remove the client system.

5. Press Return for the Configuration menu.

6. Restart the Agent for your changes to take effect. For instructions, see section “Restarting the RA200 Agent” in this chapter.

Viewing the Authorized Client List

To view a list of client systems that are authorized to access the RA200 Agent, follow these steps:

1. At the command prompt, type the following and then press Return. The Configuration menu appears:

   ```
   # /usr/sbin/RA200config.sh
   ```

2. Type 7 to view the client systems and then press Return. A list of Clients authorized to access the Agent appears.

3. Press Return for the Configuration menu.
Configuring the RA200 Agents

Restarting the RA200 Agent

You must restart the Agent after making any changes to the configuration. To restart the Agent, perform the following steps:

1. Verify that the RA200 Storage Windows on all of your client systems are closed.
2. At the command prompt, type the following and then press Return. The Configuration menu appears:
   
   ```
   # /usr/sbin/RA200config.sh
   ```
3. Type 2 and then press Return. You are given the status of the Agent and asked if you would like to stop or restart the RA200 Agent.
4. Type r and then press Return. The Agent is restarted.
5. Press Return for the Configuration menu.

Stopping the Agent

When you stop the Agent, it will stop monitoring the storage connected to the KZPSC and KZPAC controllers. To stop the Agent, perform the following:

1. Verify that the RA200 Storage Windows on all of your client systems are closed.
2. At the command prompt, type the following and then press Return. The Configuration menu appears:

   ```
   # /usr/sbin/RA200config.sh
   ```
3. Type 2 and then press Return. You are given the status of the Agent and asked if you would like to stop or restart the RA200 Agent.
4. Type s and then press Return. The software stops the Agent.
5. Press Return for the Configuration menu.

Starting the Agent

To start the Agent, perform the following:

1. Verify that the RA200 Storage Windows on all of your client systems are closed.
2. At the command prompt, type the following and then press Return. The Configuration menu appears:

   ```
   # /usr/sbin/RA200config.sh
   ```
3. Type 2 and then press Return. You are given the status of the Agent and asked if you would like to start the RA200 Agent.
4. Type y and then press Return. The software starts the Agent.
5. Press Return for the Configuration menu.

Enabling and Disabling the Agent Startup at System Boot

The default is for the Agent to start at system boot; however, you may want to change this option. For example, if you need to check your system, you may not want the Agent to start at boot time. The following instructions tell you how to change the default:

1. At the command prompt, type the following and then press Return. The Configuration menu appears:
   
   # /usr/sbin/RA200config.sh

2. Type 3 to disable the Agent startup at system boot. Press Return. You are told the startup at system boot is currently enabled, and you are asked if you would like to disable this option.
3. Type y and then press Return. The Agent will no longer start at system boot.
4. Press Return for the Configuration menu.
5. You can return the Agent startup option to the system default by repeating steps 1–4. When you repeat the steps, you will be asked if you want to enable the Agent startup at system boot.
Usage Notes and Troubleshooting

This appendix describes the following general usage notes and tips for troubleshooting problems for Command Console and Agent:

- System Requirements
- General Usage Notes
- Troubleshooting for RA200 Client and Agents
- Troubleshooting Connection Problems

System Requirements

This section describes the special considerations for various operating systems and Agents. It contains the following topics:

- Enabling RA200 Host Event Logging
- Enabling StorageWorks Fault Management for the RA200
- Firmware Upgrades for the RA200
- Minimal RA200 Driver for Windows NT
- Network Port Assignments
- Requirements for TCP/IP Stacks on OpenVMS Version 7.2

Enabling RA200 Host Event Logging

RA200 Agents have the ability to retrieve and log certain SCSI information. This information is useful to Compaq personnel attempting to diagnose problems with the physical devices installed behind your RA200 controller. This function is disabled by default because the information logged can occupy large amounts of disk space and it is generally meaningful to only trained service personnel. If you wish to enable this logging, you perform the following:
Create a file called `RA200EventLogEnable` (no extension) in one of the following directories:

- For Windows NT—Create the directory, C:\Winnt\System32\SWCCSupLogs, and create the aforementioned file in it.
- For Tru64 UNIX—Create the aforementioned file in the `/var/adm` directory.
- For OpenVMS—Create the aforementioned file in the directory pointed to by the logical `SYS$ERRORLOGS`.

**NOTE:** If the logical `SYS$ERRORLOGS` is not defined on your OpenVMS operating system, create a directory for your log files and define this logical to point to it prior to enabling this function. Refer to your OpenVMS documentation on how to properly define this logical.

The RA200 Agent will dynamically detect the existence of the `RA200EventLogEnable` file (the contents do not matter) and enable the logging function accordingly. Restarting the RA200 Agent is not necessary.

Once enabled, any SCSI sense data recorded will be logged to files in the same directory as the `RA200EventLogEnable` file. The log files will be named “`RA200Events_<system_name>_<controller_name>.log`” where `<system_name>` will be the name of the system that the Agent is running on, and `<controller_name>` will be the name of the controller as it is identified by the RA200 Agent. The files will contain formatted ASCII entries that will relay the necessary support information to service personnel.

**CAUTION:** The log files created can grow rapidly in size if there are many problems with the controller and/or storage devices. Monitor the size of the log files created. Archive or delete them as needed.

---

### Enabling StorageWorks Fault Management for the RA200

Before starting the RA200 Agent, verify that StorageWorks Fault Management is enabled for each KZPAC and KZPSC controller that you want to manage with SWCC.

You must enable StorageWorks Fault Management by using the stand-alone RAID Configuration Utility (RCU) so StorageWorks Command Console can support these controllers.

**NOTE:** For more information on using RCU, refer to the manual RAID Array 230/Plus Subsystem RAID Configuration Utility - User's Guide, part number AA-R07GA-TE Appendix A.

To enable StorageWorks Fault Management, perform the following:
1. Run the RCU.

2. From the Main menu of the RCU, highlight the Controller Setup option by using the arrow keys and then press Return. The Edit/View Parameters menu appears.

3. If necessary, use the arrow keys to highlight Hardware Parameters and then press Return. The Hardware Parameters window appears.

4. Use the arrow keys to highlight StorageWorks Fault Management. If this parameter is displayed as Disabled, press Return to change the setting to Enabled.

5. Press ESC to return to the Edit/View Parameters screen.

6. Press ESC again. If you made no parameter changes, the Main menu appears.

7. If you changed a controller setting, the RCU will prompt you to save the altered controller configuration. Use the arrow keys to highlight Yes and then press Return. The Main menu appears.

**Firmware Upgrades for the RA200**

Before starting the RA200 Agent, you must first upgrade your RA200 controller’s firmware to a minimum of version 2.49.

The firmware upgrade program must be run from an MS-DOS bootable floppy for an Intel platform.

The zip file from the Compaq Web page contains the following files:

- \KZPXC\Intel
  - readme.txt
  - Ra200fl.exe - Firmware download program for Intel
  - Ra200rcu.exe - RCU program for Intel
  - SWXCRFWP.249 - Revision 249 firmware for RA230/230+

**NOTE:** For complete installation instructions, refer to the manual *RAID Array 230/Plus Subsystem RAID Configuration Utility - User's Guide*, part number AA-R07GA-TE Appendix A.

**Specifying Command-Line Parameters**

**NOTE:** Read the introductory paragraphs in the section “Firmware Upgrades for the RA200” in this appendix.

To upgrade the firmware, you must first shut down the operating system. There are two ways to specify command-line parameters for the firmware download utility:
Usage Notes and Troubleshooting

- An explicit name for the downloaded image for each controller in the system, up to four controllers.
- The -v option when the same image was used for each controller in the system with different RA200 controllers, specify the firmware for each.

1. At the command prompt, type the following:
   RA200FL.EXE xxxx yyyy zzzz aaaa
   where xxxx yyyy zzzz aaaa are firmware image names, for example, SWXCRFWP.249. Dummy parameters can be specified if you do not wish to load the firmware for a specific controller. Leaving yyyy in the command above would cause the second controller’s firmware to stay the same.

2. As an option, at the command prompt, type the following:
   RA200FL.EXE -v xxxx
   where xxxx is the revision of the firmware, for example, 249. This will use the same firmware image for each controller in the system.

To run the RAID Configuration Utility (RCU), refer to the manual RAID Array 230/Plus Subsystem RAID Configuration Utility - User’s Guide, part number AA-R07GA-TE, Chapter 1. Contact your Compaq sales representative for additional copies of the manual.

Finding an Unzip Utility

The following versions have been used to unzip the firmware files:
- Microsoft Windows NT - Info-ZIP unzip 5.32 (Intel)
- Winzip 6.3 (Intel native)
- Microsoft Windows 9x - Info-ZIP unzip 5.32
- Winzip 6.3

Always indicate that the unzip utility should retain the directory structure (default for Infusible unzip).

Network Port Assignments

SWCC Clients and Agents communicate by using sockets. The SWCC installation attempts to add entries into each system list of services (services file or for UCX, the local services database).
If the SWCC installation finds an entry in the local services file with the same name as the one it wants to add, it assumes the one already in the file is correct.

The SWCC installation may display a message, stating that it cannot upgrade the services file. This happens if it finds an entry in the local services file with the same number as the one it wants to add, but with a different name. In that case, appropriate port numbers must be obtained for the network and added manually to the services file.

There are two default port numbers, one for Command Console (4998) and one for the device-specific Agent and Client software. The exception is the software for the RA200 Agent and Client, which has two (instead of one) default network port numbers.

The OpenVMS configuration files add the services entries, not the PCSI installation kit.

Table A–1 lists the port names, default numbers, and devices as they may appear in the services file:

**Table A–1: Port Names and Default Numbers**

<table>
<thead>
<tr>
<th>Port Name</th>
<th>Number</th>
<th>Device</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spgui</td>
<td>4998/tcp</td>
<td>#Command Console</td>
</tr>
<tr>
<td>Emu</td>
<td>4990/tcp</td>
<td>#Environmental Monitoring Unit</td>
</tr>
<tr>
<td>Ccfabric</td>
<td>4989/tcp</td>
<td>#Fibre Channel Interconnect Client and Agent</td>
</tr>
<tr>
<td>Ccagent</td>
<td>4997/tcp</td>
<td>#RA200 Client and Agent</td>
</tr>
<tr>
<td>Spagent2</td>
<td>4995/tcp</td>
<td>#RA200 Client and Agent</td>
</tr>
</tbody>
</table>

Port names and numbers must be exactly the same for all systems that need to communicate with each other on the network, running SWCC.

**Requirements for TCP/IP Stacks on OpenVMS Version 7.2**

Table A–2 lists the requirements for TCP/IP stacks on OpenVMS version 7.2.
Usage Notes and Troubleshooting

Table A–2: Requirements for TCP/IP Stacks

<table>
<thead>
<tr>
<th>TCP/IP Stack</th>
<th>Minimum Version</th>
<th>Supported/Not Supported</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>UCX</td>
<td>4.x</td>
<td>Not Supported</td>
<td>This stack is not supported under OpenVMS version 7.2</td>
</tr>
<tr>
<td>TCPIP (formerly UCX)</td>
<td>5</td>
<td>Supported</td>
<td>Minimum ARB_SUPPORT setting of 2. **</td>
</tr>
<tr>
<td>MultiNet</td>
<td>4.1B</td>
<td>Supported*</td>
<td>Minimum ARB_SUPPORT setting of 2. **</td>
</tr>
<tr>
<td>TCPware</td>
<td>5.3-3</td>
<td>Supported*</td>
<td>Minimum ARB_SUPPORT setting of 2. **</td>
</tr>
</tbody>
</table>

* This stack requires a security patch from Process Software to support OpenVMS version 7.2. Go to www.process.com

** If you have MultiNet and/or TCPware TCP/IP stacks on your computer, set ARB_SUPPORT to less than 2. ARB_SUPPORT is a security setting for OpenVMS version 7.2. For further information on ARB_SUPPORT, please refer to your documentation on OpenVMS version 7.2.

General Usage Notes

This section provides general information on the software to help you understand certain error messages. It contains the following topics:

- Authorization Error When Adding an Agent System
- Delayed Pager and Event Notification on RAS Connections
- Increasing Screen Space for the Storage Window
- Invalid or Missing Fault Displays and Event Logs
- Continuous Pager Notification and Event Logging
- Starting Client with Network Connections
- Storage Window Does Not Display Status Changes

**Authorization Error When Adding an Agent System**

If you receive an authorization error when you add an agent system to the Navigation Tree, your client system may be missing from the Agent’s list of client system entries. If you have more than one type of Agent installed on that agent system, the name of your client system must be on each Agent’s list of client system entries.

**Delayed Pager and Event Notification on RAS Connections**

Pager and event notification may be delayed significantly when multiple client systems are using Remote Access Service (RAS) connections. The Agent sends fault messages to each client system listed in the file. The file contains a list of client systems to notify (for example, `raclient.ini` for the RA200) when a fault occurs. Client systems that are not frequently connected to the network delay this process. The delay occurs because the Agent must wait for its connections to time out before notifying the other client systems.

Move your most important systems to the top of the list of client systems in the configuration utility and the systems with RAS connections to the bottom. The Agent begins communicating to each client system from the top of this list. This will allow your more important systems to receive fault messages first.

You may also want to deselect the TCP/IP notification scheme for less important systems, especially for those using RAS connections. The Agent is prevented from sending fault messages to client systems without the TCP/IP notification scheme. The client systems that are not configured to receive TCP/IP notification will not update their Navigation Tree nor will they generate pager notification for that Agent.

**Increasing Screen Space for the Storage Window**

It is highly recommended that you run the Client on a monitor that has a minimum of super VGA (SVGA) (800X600) display resolution because the Storage Window requires a certain amount of screen space to properly display its contents. When you use a VGA display resolution, screen space becomes more limited. If you must use a VGA resolution, select the Auto Hide check box in the Taskbar Properties window to increase screen space for the Storage Window.
Invalid or Missing Fault Displays and Event Logs

Invalid or lost notifications may occur when the client system’s connection with a subsystem is broken. The client system receives notification for most changing subsystem faults at monitored intervals. This means that if the client system is no longer notified of subsystem faults, then changes to that subsystem will not be displayed in the client system’s Navigation Tree, Storage Window, and Windows NT Event Viewer.

For example, while the client system’s connection is broken with a subsystem, you will not receive event logs pertaining to that subsystem, except to say that the connection has been broken.

The following list provides the reasons for broken connections. After you have fixed the physical problem that is listed below, you will need to close and reopen the Storage Window to obtain the latest status.

- For RAS connections — Remote Access Service (RAS) connections are not full time. Events that occur when there is no RAS connection are not logged to the Windows NT Event Logging facility.
- For serial controller connections — There may be a bad or missing serial cable. To repair this situation, replace or plug in the cable.
- For host port SCSI connections — There may be a bad or missing SCSI host cable. There may be no logical units configured on the controller that was selected at the time of Client startup.
- For network connections — Agent may be missing or not running. There may be network discontinuity. The Agent may not be properly configured for your Clients.
- For controller halts, resets, or hang-ups — To repair this situation, restart or replace the controller.
- The virtual disk being used for communicating with the subsystem is no longer available.

Continuous Pager Notification and Event Logging

You may experience continuous paging notification and Windows NT event logging in response to subsystem faults, even though you have exited Command Console. This behavior is normal. It is the result of Client starting the paging and event logging activity while it was running.
Client’s AES module runs under Windows NT as a service. It continues to run, even after you have exited the program. The AES module communicates with Agents, and it activates paging and event logging when a subsystem event occurs.

**NOTE:** When you stop AES on a client system, you are telling the Agent software to no longer send updates to that client system.

To stop paging and event logging on a client system, perform the following for Windows NT:

1. Click Start > Settings > Control Panel > Services > AsyncEventSvc.
2. Click Stop.

### Starting Client with Network Connections

To start Command Console with network connections to your storage subsystems, perform the following:

1. Click in Start > Programs > Command Console.

You can also type the following line at a command prompt on Windows NT to start the Client with network connections:

```
\path_to_client_directory\swcc.exe -d your_host_system your_host_subsystem
```

where -d your_host_system your_host_subsystem is an optional set of parameters that enables you to specify a system and a subsystem to start the Client. If you specify these parameters, the Client opens with the system selected and the subsystem displayed in the Storage Window. If the Client is not already aware of the system and the subsystem, it adds them to the Navigation Tree.

### Storage Window Does Not Display Status Changes

When a Storage Window loses a connection with a subsystem, it is unable to display that subsystem’s change of status. This is because the Storage Window receives notification for most changing subsystem conditions at monitored intervals.

For example, while the client system’s connection is broken with a subsystem, the Storage Window may display old faults that were cleared.

The following list provides the reasons for broken connections. After you have fixed the physical problem that is listed below, you will need to close and reopen the Storage Window to obtain the latest status.
Usage Notes and Troubleshooting

- For RAS connections — RAS connections are not full time. Events that occur when there is no RAS connection are not logged to the Windows NT Event Logging facility.
- For serial controller connections — There may be a bad or missing serial cable. To repair this situation, replace or plug in the cable.
- For host port SCSI connections — There may be a bad or missing SCSI host cable. There may be no logical units configured on the controller that was selected at the time of Client startup.
- For network connections — Agent may be missing or not running. There may be network discontinuity. The Agent may not be properly configured for your Clients.
- For controller halts, resets, or hang-ups — To repair this situation, restart or replace the controller.

Multiple Communication Lost Messages

AES on a client system monitors each agent system currently in the Client’s Navigation Tree. AES will generate a page and an event log entry if an Agent fails on any of the systems. Remove the system entry in the Command Console’s Navigation Tree to stop the pages and event log entries.

Event Updates

Any node added to the Navigation Tree using cluster alias and any Storage Window open off of that cluster alias must be manually updated. If you have a pager configured, you will need to add the individual nodes of the cluster to the Navigation Tree for automatic updates.

Multiple Pages

AES may send multiple pages when an Agent moves from a failing node to a better one. When the Agent fails over, a TCP/IP peer reset error may appear in the running Storage Window that had been connected to that Agent.

Troubleshooting for RA200 Client and Agents

The following information provides solutions for various problems. This section contains the following topics:
• Changing the RA200 Controller Settings
• Commands from the Storage Window Fail to Reach the RA200 Agent
• Virtual Disk Initialization Warning

Changing the RA200 Controller Settings

To change the controller settings, first shut down your operating system. You can then
run the RAID Array 200 Series Stand-Alone Configuration Utility that came with
your controller. Run this utility at the console level. Controller parameters that you
 can modify include the following:
• Battery backup (enable or disable)
• Command tagging (enable or disable)
• Controller read ahead (enable or disable)
• Default rebuild rate
• Delay the interval the controller waits before spinning up the next number of
devices
• Device spin up option (automatic or on power up)
• Number of devices to spin up at a time
• SCSI data transfer rate
• StorageWorks Fault Management (enable or disable)
• Stripe size

For more information about controller parameters, refer to the documentation
provided with your RA200 Series controller kit.

Commands from the Storage Window Fail to Reach the RA200 Agent

Whenever you stop the Agent, you need to close and reopen the RA200 Storage
Windows on all client systems to restore the connection. When you stop the Agent,
the connection to the RA200 Storage Window is lost. As a result, your Storage
Window will not receive messages of failed TCP/IP communications. Your commands
from a RA200 Storage Window may also fail to reach the RA200 Agent. When this
occurs, you will receive no warnings.
Usage Notes and Troubleshooting

Virtual Disk Initialization Warning

Your data may become corrupt if you allow other applications to access a virtual disk during its initialization. This is because an initialization writes “blank data” to the entire virtual disk. Confirm that the initialization of a RA200 virtual disk is completed before allowing another application to use the disk.

When you used the RA200 Client to create a virtual disk on a remote system, the operating system immediately makes this disk available to all processes. Other processes are able to read data from and write data to the new virtual disk while the RA200 Client initializes the disk.

Initialization of Logical Drive Will Take Some Time

The initialization of logical drives is done in a background process where a small number of inputs/outputs are issued every few seconds. This reduces the resources needed by the RA200 Agent and ensures user initiated inputs/outputs are processed by the RA200 in a reasonable manner. This means that the initialization of a logical drive may take some time, but inputs/outputs to existing logical drives will not suffer.

Troubleshooting Connection Problems

This section documents known connection problems and suggests some solutions. SWCC is a TCP/IP socket-based application. As a result, SWCC requires that each node running a SWCC Client or Agent must have access to a valid hosts file or Domain Name Service (DNS) server. The valid hosts file must include at least the system itself and any other systems running a SWCC Client or Agent that it will connect to.

Access Denied Problem

This section covers some of the most common reasons for a Client to receive an Access Denied message when it attempts to add an agent system to the Navigation Tree.

Aliases Not Checked

When SWCC Agents scan the Client authorization list, they do not check aliases. The entry in the Client authorization list must match that returned by a gethostbyaddr call in the hostent h_name field. SWCC will not scan the hostent alias list to check if an alias may match the Client authorization list.
**Client System Not on Agent's List**

The client system may not on the authorized client system list for the Agent.

**Entry in the Client Authorization List Does Not Match**

Generally, the entry in the Client authorization list for an Agent must match what `gethostbyaddr(<client IP address>)` will return in the hostent `h_name` field when `gethostbyaddr(<client IP address>)` is executed on the Agent system. If hosts files are not exactly the same on all systems, the `h_name` returned may vary on different Agent systems. For example,

```
xxx.xxx.xxx.xxclient.somewhere.comclient
```

will return `client.somewhere.com` in the `h_name` field, but

```
xxx.xxx.xxx.xxxclientclient.somewhere.com
```

will return `client` in the `h_name` field.

In some situations, you can configure the way a system uses DNS and its local hosts file. Please refer to your system documentation to find how your system is configured. Some systems may be configured to do the following:

- Check its local hosts file first, then go to DNS.
- Go to DNS first, then check its local hosts file.
- Ignore DNS even if configured.
- Ignore the local hosts file.

The best way to verify what needs to be used for a Client name in the Client authorization list is to write a program that runs on the agent system and prints the `h_name` field returned by `gethostbyaddr(<client IP address>)`. Remember, the dynamic IP address allocation is not supported.

**Multiple Agents**

If the agent system is running multiple SWCC Agents (for example, to support different controller types) then the client system must be authorized for all Agents. If the client system is missing from any authorized Client list of an Agent, then that Agent cannot be added to the Navigation Tree.
Add New System May Cause Client to Stop Responding

The SWCC Client may stop responding when you attempt to add a system by using the agent system's IP address rather than the agent system's node name. This occurs when the client system does not have a DNS server configured that knows the agent system, and the agent system is not in the client system's hosts file. To correct this situation, add the agent system to the hosts file on the client system.

If you receive an Invalid host or Host not known message when you attempt to connect to an agent system, the solution is not to try the IP address. Fix your DNS server configuration, or if that is correct, confirm the DNS server knows the agent system. If you are not using DNS, make sure the agent system is in the client system's hosts file. Remember, WINS is not supported by SWCC.

No Agent Running Message When Adding System to the Navigation Tree

When trying to add a new system to the Navigation Tree, you may receive a message, stating No Agent running on specified system. This message can appear for several reasons. The error most likely occurred as a result of one of the following:

- Wrong system name was entered.
- Agents were not installed on the entered system.
- Agents were installed on a system that stopped functioning.
- The specific Client required to support the Agents, running on the agent system, was not installed. For example, if the agent system only has a Fibre Channel Interconnect Agent and the client system has only an HSJ50 Client, the No Agent Running message will appear.

To check if Client support for an Agent had been installed, look at the following registry key:

```
HKEY_LOCAL_MACHINE\Software\DigitalEquipmentCorporation\Command
Console\AppletManager
```

You will see a series of keys for supported products.

- Port names and numbers in the services file may be missing or may not match between the Client and Agent. This may occur if the default value for a SWCC port was already in use. There is a list of port numbers and their default values in “Network Port Assignments.”
This glossary defines terms used in this guide or related to this product and is not a comprehensive glossary of computer terms.

**Agent System**
A computer that has the Agent installed.

**Asynchronous Event Service**
Runs in the background as a service, collects and passes all traps from the subsystems to the appropriate Navigation Trees and individual pagers. It is a component of Command Console. Needs to be running for your client system to receive updates.

**Client System**
A computer that has Windows NT 4.0 and the Windows-based Client software installed.

**StorageWorks Command Console**
The main program that refers to the overall program.

**Command Console**
The main program that provides event notification and the Navigation Tree.

**Device-Specific Client**
In this software release, it provides a Storage Window for a particular device.

**Device-Specific Agent**
Collects data from the subsystems and passes the information along to the device-specific Client. Enables the Client to communicate with your subsystems.
**Glossary**

**Navigation Tree**
Provides access to the Storage Window. Shows the status of your storage systems. It displays your systems in a hierarchical order. A subsystem is shown to be connected to a system, and the Storage Window is shown to be connected to a subsystem.

**Navigation window**
Use to add a system. Contains the Navigation Tree. It is the window that you see when you click StorageWorks Command Console in Start > Programs > Command Console.

**Storage Window**
Displays the status of a particular storage subsystem.

**Subsystems for Device Management**
Comprised of adapters.

**Storage Subsystem for Controllers**
A controller and an array of physical devices.
Index

A
access denied problem  A–12
access problems
  troubleshooting  A–12
accessing the Configuration menu
  RA200 Agents
    OpenVMS  5–3
    Tru64 UNIX  5–11
adding a client system entry
  RA200 Agents
    OpenVMS  5–4
    Tru64 UNIX  5–12
Adobe Acrobat Reader
  installing  3–1
Agent access password  1–5
aliases not checked  A–12
Asynchronous Event Service
  Windows NT  3–2
asynchronous event service
  continuous event logging  A–8
  continuous pager notification  A–8
  invalid or lost notifications  A–8
RAS connections
  RA200 Agents  A–7
authorization error
  adding an agent system  A–7
authorized reseller, Compaq  xi

B
before installing
  RA200 Agents
    OpenVMS  4–1
    Tru64 UNIX  4–5
button names, convention defined  vii

C
Caution, symbol and definition  ix
ccclient.txt  3–1
changing password
  RA200 Agents
    OpenVMS  5–3
    Tru64 UNIX  5–12
Client
  starting with network connections  A–9
  Storage Window does not display status changes  A–9
Client stops responding  A–14
client system access options  1–3
client system not on Agents list  A–13
client system notification options  1–4
cluster integration
  event updates  A–10
  multiple communication lost messages  A–10
  multiple pages  A–10
Command Console
  operating system considerations  2–2
Command Console Agent  1–3
Command Console Client  1–2
  connection types  1–1,  2–1
  network connection  2–1
  features  1–3
  installing  3–1
command names, convention defined  viii
Compaq
  authorized reseller  xi
  technical support  xi
  website  xi
Index

configuration menu
  RA200 Agent
    OpenVMS  5–3
    Tru64 UNIX  5–11
configuring
  RA200 Agents
    OpenVMS  5–3
    Tru64 UNIX  5–11
connection problems
  troubleshooting A–12
continuous event logging  A–8
conventions
  button names, defined vii
  command names, defined viii
  dialog box names, defined vii
  directory names, defined vii
  drive names, defined viii
  filenames, defined viii
  key sequences, defined vii
  keyboard keys, defined vii
  menu command sequences, defined viii
  menu items, defined vii
  named keys, defined vii
  system responses, defined viii
  URLs, defined viii
  user input, defined viii

D
delayed pager notification on RAS connections  A–7
deleting a client system entry
  RA200 Agents
    OpenVMS  5–8
    Tru64 UNIX  5–15
deleting configuration files
  RA200 Agents
    OpenVMS  4–4
dialog box names, convention defined vii
directory names, convention defined vii
disabling and enabling Agent startup
  RA200 Agents
    OpenVMS  5–10
    Tru64 UNIX  5–17
drive names, convention defined viii

E
electrical shock hazard, symbol and definition ix
enabling and disabling Agent startup
  RA200 Agents
    OpenVMS  5–10
    Tru64 UNIX  5–17
enabling host event logging
  RA200 Agents
    Tru64 UNIX  A–1
enabling StorageWorks Fault Management
  RA200 Agents  A–2
entry does not match  A–13
equipment symbols ix
establishing
  network connection  2–1
  event logging
  RA200 Agents
    Tru64 UNIX  4–9
excessive weight, symbol and definition x

F
fault management
  RA200 Agent  A–2
filenames, convention defined viii
finding an unzip utility A–4
firmware upgrades
  RA200 Agents  A–3
  specifying command-line parameters A–3
  unzip utility A–4

G
general usage notes A–6
getting help xi
  Compaq technical support xi
  Compaq website xi

H
Help, obtaining xi
host event logging
  RA200 Agent  A–1
host-bus SCSI connection
figure 2–1
hot surface, symbol and definition  x
how to set up this software  1–1

I
Important, defined ix
installing
Adobe Acrobat Reader  3–1
Command Console Client  3–1
  Windows NT  3–1
RA200 Agents  4–1
  OpenVMS  4–2
  Tru64 UNIX locally  4–6
invalid or lost notifications  A–8

K
key sequences, convention defined vii
keyboard keys, convention defined vii

M
menu command sequences, convention defined viii
menu items, convention defined vii
message
  No Agent Running  A–14
  modifying a client system entry
    RA200 Agents
      OpenVMS  5–6
      Tru64 UNIX  5–13
  multiple Agents  A–13
  multiple power source, symbol and definition  x

N
named keys, convention defined vii
network connection  2–1
  establishing  2–1
network connections
  starting Client  A–9
network interface connection, symbol and definition ix
network port assignments  A–4
No Agent Running message  A–14

Note, defined ix

O
OpenVMS version 7.2
  TCP/IP stack requirements  A–5
operating system considerations
  Command Console  2–2

R
RA200 Agents
  before installing OpenVMS  4–1
  before installing Tru64 UNIX  4–5
  configuring on OpenVMS  5–3
    adding client system entry  5–4
    changing Agent access password  5–3
    modifying a client system entry  5–6
    removing a client system entry  5–8
    viewing a Client list  5–9
  configuring on Tru64 UNIX  5–11
    adding a client system entry  5–12
    changing the Agent access password  5–12
    modifying a client system entry  5–13
    removing a client system entry  5–15
    viewing the authorized Client list  5–15
  enabling and disabling startup
    OpenVMS  5–10
    Tru64 UNIX  5–17
  event logging  4–9
  firmware upgrades  A–3
    specifying command-line parameters  A–3
  unzip utility  A–4
  host event logging  A–1
  installing  4–1
  installing on Tru64 UNIX  4–6
  installing on Tru64 UNIX locally  4–6
  OpenVMS
    installing  4–2
    removing from OpenVMS  4–4
  restarting on OpenVMS  5–9
  restarting on Tru64 UNIX  5–16
  starting on OpenVMS  5–10
  starting on Tru64 UNIX  5–16
  stopping on OpenVMS  5–10
Index

stopping on Tru64 UNIX  5–16
StorageWorks fault management  A–2
toggling Agent startup on OpenVMS  5–10
toggling Agent startup on Tru64 UNIX  5–17
troubleshooting  A–10
RA200 Client
  failed TCP/IP communications not reported  A–11
troubleshooting  A–10
  virtual disk initialization warning  A–12
RA200 controller
  changing the RA200 controller settings  A–11
rack stability  x
removing
  RA200 Agents
    OpenVMS  4–4
requirements
  TCP/IP stacks
    OpenVMS  A–5
restarting
  RA200 Agents
    OpenVMS  5–9
    Tru64 UNIX  5–16
S
screen space
  improving  A–7
services file  A–5
setting up the software  1–1
starting host event logging
  RA200 Agents
    Tru64 UNIX  A–1
starting StorageWorks fault management
  RA200 Agents  A–2
steps to install the software  1–1
stopping and starting
  RA200 Agents
    OpenVMS  5–10
    Tru64 UNIX  5–16
Storage Window
  increasing screen space  A–7
  Storage Window does not display status changes  A–9
StorageWorks fault management
  RA200 Agent  A–2
symbols
  in text  ix
  on equipment  ix
system requirements  A–1
system responses, convention defined  viii
T
TCP/IP stacks
  requirements
    OpenVMS  A–5
technical support, Compaq  xi
text symbols  ix
toggling the Agent startup
  RA200 Agents
    OpenVMS  5–10
    Tru64 UNIX  5–17
traps  3–2
troubleshooting
  access denied  A–12
  aliases not checked  A–12
  Client stops responding  A–14
  client system not on Agents list  A–13
  connection problems  A–12
  delayed pager and event notification on RAS
    connections  A–7
  entry does not match  A–13
  multiple Agents  A–13
  No Agent Running message  A–14
  RA200  A–10
    changing the RA200 controller settings  A–11
    virtual disk initialization warning  A–12
U
uninstalling
  RA200 Agents
    OpenVMS  4–4
unzip utility  A–4
URLs, convention defined  viii
user input, convention defined viii
using the Configuration menu
   RA200 Agents
      OpenVMS 5–3
      Tru64 UNIX 5–11
Using the Internet Protocol Address A–14
V
virtual disk
   initialization warning
      RA200 Client A–12
W
Warning
electrical shock hazard symbol, defined ix
excessive weight symbol, defined x
hot surface symbol, defined x
multiple power source symbol, defined x
network interface connection symbol, defined ix
symbol and definition ix
websites
   Compaq storage xi
   Compaq technical support xi
Windows NT
   Asynchronous Event Service 3–3
   increasing screen space A–7